Agilent ChemStation

Getting Started with New ChemStation Workflow
Notices

© Agilent Technologies, Inc. 2006, 2007-2010

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Manual Part Number
G2170-90044

Edition
2/2010
Printed in Germany
Agilent Technologies
Hewlett-Packard-Strasse 8
76337 Waldbronn

Software Revision
This guide is valid for B.04.02 SP1 revisions or higher of the Agilent ChemStation software.

Microsoft ® is a U.S. registered trademark of Microsoft Corporation.

Warranty

The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered and licensed as "Commercial computer software" as defined in DFAR 252.227-7014 (June 1995), or as a "commercial item" as defined in FAR 2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.

For Research Use Only
In analytical laboratories, chromatography data need to be acquired efficiently in a short time. Clarifying ambiguous results can be time-consuming, and may result in high administrative costs. Since ChemStation Revision B.02.01, data storage and data browsing capabilities have been improved to enable fast review and reprocessing of result data.

In this manual, the efficient use of the new data storage and retrieval functions in ChemStation B.04.02 SP1 to boost your lab’s productivity are described.

1 **ChemStation Data Structure**

   This chapter gives an overview of the differences between the data structure used in ChemStation revisions prior to B.02.01 and the new data structure in revision B.02.01 and its successors.

2 **Data Acquisition**

   This chapter explains how the new data structure influences the workflow for the acquisition of data for sequences and single runs.

3 **Data Analysis**

   This chapter outlines the data analysis and review options that are available, and explains how consideration of the data structure affects your choice of options.

4 **Workflow with Unique Folder Creation switched off**

   This chapter provides information on working with **Unique Folder Creation** switched off which allows you to store data as in ChemStation revisions B.01.03 or earlier. This mode does not take full advantage of the latest data review and reprocessing functionality in ChemStation.
## Contents

1. **ChemStation Data Structure**  
   - ChemStation prior to B.02.01  
   - ChemStation B.02.01 and higher

2. **Data Acquisition**
   - Data Acquisition

3. **Data Analysis**
   - Data Analysis
   - Data Analysis: Data Review
   - The ChemStation User Interface during Data Review
   - Data Analysis: Reprocessing Data

4. **Workflow with Unique Folder Creation switched off**
   - Working with "Unique Folder Creation" on or off?
   - Workflow with Unique Folder Creation switched off
   - Sequence Container Migration
This chapter gives an overview of the differences between the data structure used in ChemStation revisions prior to B.02.01 and the new data structure in revision B.02.01 and its successors.
ChemStation prior to B.02.01

In ChemStation revisions prior to B.02.01, sequences, methods and the generated data files and results were stored in fixed, specified and separated locations. For example, methods were referenced by name in a sequence and it was the user’s responsibility to maintain the integrity of methods, sequences, and data files. Because of this, the long-term archiving of data, and reproduction of results was a tedious task. Users had to document the chromatogram, results, and associated method; this was the case not only for regulated labs, but also for some areas of unregulated labs (such as environmental labs). In ChemStation prior to B.02.01, this could be achieved only by printing everything in a report.
In order to strengthen the association between data files and methods, the following new data organization scheme has been implemented with ChemStation B.02.01 and higher. When used with the ChemStation, the Agilent OpenLAB Enterprise Content Manager (ECM) also makes use of the new data concept, since the complete data set (sequence/methods/data files) can now be transferred (archived) to ECM as one entity.

**Figure 1** Sequence Acquisition B.02.01 and higher

The methods in the folder Chem32\1\methods serve as master methods, i.e. during acquisition and data analysis, they remain unchanged.

Similarly, the sequences in the folder Chem32\1\sequence serve as sequence templates that can be used to rerun (but not reprocess) a sequence several times.
The data storage pattern varies depending on whether single run data or sequence data is acquired:

1. When a sequence is executed, a new folder is automatically created (sequence container) with a unique name in the specified subdirectory. When a single sample is run, the data file (*.d) is written to the specified subdirectory.

2. For sequence data, the executed sequence template (*.s) and all the methods (*.m) involved are copied into the sequence container. The copies of the methods are called the sequence methods in order to distinguish them from the original master methods.

All sequence-related tasks (e.g. acquisition and data analysis) are performed on the copies of the sequence and the methods. Therefore, the sequence template and the master methods remain unchanged for future sequence execution.

Any changes performed on the sequence during sequence during acquisition, e.g. adding lines to sequence table, are performed on the copy of the sequence file in the sequence container. The sequence template remains unchanged.

Similarly, any changes in the method, i.e. updates in the calibration table in case of calibration runs, are reflected in the sequence methods, but not in the master methods.

While executing the sequence, all generated data files (*.d) are stored in the sequence data folder, along with the corresponding batch file (*.b) and sequence log file (*.log).

3. Each data file contains two copies of the method used to create the run.
   - The first one, called ACQ.M, is saved directly after the acquisition part of the method is completed.
   - The second copy, called DA.M, is saved after completion of the data analysis part.

Both of these methods contain the complete method parameters, including acquisition and data analysis parameters.

ACQ.M is intended to ensure the preservation of the original method parameters for each specific data file. The acquisition parameters can be viewed and printed in Data Analysis view.
The DAM can be modified during data analysis in order to store data analysis parameters that do not apply to all runs of a sequence, but are specific for a certain data file, e.g. timed integration events. The following chapters explain the impact of this structure on typical workflows in more detail. The corresponding settings in the ChemStation dialogs are also shown.
1 ChemStation Data Structure
ChemStation B.02.01 and higher
This chapter explains how the new data structure influences the workflow for the acquisition of data for sequences and single runs.
Starting with ChemStation B.02.01, flexible data storage for single runs and sequences allows you to specify various saving locations without reconfiguration. The **Paths** tab in the **Preferences** dialog box in the **View** menu gives you the opportunity to add multiple paths in addition to the default path `C:\chem32\x\DATA` (where `x` is the instrument number). Using the **Add** and **Remove** buttons, existing paths can be simply deleted, or you can navigate to a selected location and add the path to the new location into the **Preferences**. The default path cannot be removed from the list, but it can be changed in the **Configuration Editor**.

![Preferences Dialog / Paths Tab](image)

**Figure 2**  Preferences Dialog / Paths Tab

All newly specified Data Paths are then available for selection in the **Sample Info/Sequence Parameters** dialog boxes when performing runs.
In order to run a sequence, appropriate pre-defined methods must be available. These are the master methods as outlined above. Typically, master methods and sequence templates are worked on in the Method and Run Control view of the ChemStation. For this reason, in Method and Run Control view, the ChemStation Explorer provides access to master methods and sequence templates.

The sequence template references these methods in the sequence table.
As explained previously, when a sequence is run with sequence template 
<sequence_name>.S, and the master method <method_name>.M is used, a 
new folder is created that contains all resulting files from the sequence 
run ("sequence container").

The location of this folder is determined by the settings in the **Sequence 
Parameters** dialog box; the naming of this folder is determined by the 
**Sequence** tab of the **Preferences** dialog box. By default, the name is 
<sequence_name> <acquisition_date> <acquisition_time>, but it can be 
configured by using the tokens Operator, Instrument, Counter, and PC 
Name, or you can manually enter any name. If the **Name Pattern** would not 
result in unique names for the sequence containers, the ChemStation will 
append a counter to ensure uniqueness.

![Preferences Dialog / Sequence Tab](image)

**Figure 4** **Preferences Dialog / Sequence Tab**

At the start of an acquisition sequence, the method specified in the 
sequence table is copied from the master methods folder into the sequence 
container. In addition, a copy of the sequence is created and placed with 
the sequence log and the batch (*.b) file in the sequence container. All 
updates of the method (e.g. updates of the calibration table) are written to 
this sequence method in the container. All necessary files are now
available for future data review and reprocessing, without changes that were applied to the master method or sequence template for other sequence runs.

During acquisition, the data files are stored to the sequence container. Within each data file (*.D), two additional methods, ACQ.M and DA.M, are saved for this specific run. These two methods are copies of the sequence method, preserving the state of the method as it was at the time of acquisition of the specific data file. In the case of e.g. calibration table updates the DA.M methods differ for each of the runs.

The individual acquisition method ACQ.M is intended to preserve the acquisition parameters, therefore it is recommended that you do not change this method during future data review activities. In **Data Analysis** view, the acquisition parameters of this method can be viewed and printed.

With these files saved in the sequence folder, all data review and reprocess activities can be performed without altering the master method or the sequence template. If needed, method changes can also be saved to the master method again.

### Partial Sequence Acquisition

In the case of partial sequence acquisition, the user can decide between two options:

- acquire the partial sequence into a new sequence container

or

- acquire the partial sequence in an already existing sequence container.

Acquiring the data files from a partial sequence execution into an already existing sequence container may be useful in the following scenarios:

- A single data file (or several data files) have to be overwritten, because e.g. an incorrect vial was used in the first place.

- Only the first part of the sequence has been executed in the first place, and the missing samples have to be added by executing partial sequence. This may occur in the case of an instrument failure during sequence acquisition.
Additional lines have been added to the sequence template after acquisition of the already existing lines. The additional runs are to be added to the already existing data.

Therefore, when the user selects **Partial Sequence** from the **Sequence** menu, a dialog will come up providing him the option to either select an existing sequence container from a list or to create a new sequence container.

**Figure 5  Partial Sequence Dialog**

However, in order to maintain consistency of the sequence container (so it can be completely reprocessed in **Data Analysis**), only those sequence containers are offered for partial acquisition that fulfill certain conditions:

- The name of the sequence template (source sequence) and the name of the sequence .S file in the sequence container (target sequence) are identical.
- Both the data path and the subdirectory have to be identical for the sequence files.
- The number of sequence lines in the source sequence must be equal or higher than the number of sequence lines in the target sequence.
- For each line in the target sequence the sample type and the number of injections must be identical to the values in the corresponding lines of the source sequence.
- The data file naming scheme must be identical for the two sequence files.

After leaving this dialog with **Ok** (for selecting one of the existing sequence data containers) or **New** (for creating a new sequence container), the user can select the sequence lines to be executed during partial sequence.

### Data Acquisition of Single Runs

The new data concept is also introduced for single runs. In this case the data file is saved directly into the respective subdirectory. Since only one method is employed for a single run, this method does not need to be copied into the subdirectory; all actions are performed directly with the master method. After the acquisition part of the method is completed a copy of the master method is saved into the data file directory (ACQ.M). Another copy (DA.M) is saved after the data analysis part of the master method has been executed.
2 Data Acquisition
Data Acquisition
This chapter outlines the data analysis and review options that are available, and explains how consideration of the data structure affects your choice of options.
Once the data have been acquired, they can be analyzed in ChemStation Data Analysis view. When selecting the Data tab of the ChemStation Explorer, you can load all the runs of a sequence or all single runs in a specific folder by double-clicking the corresponding symbol. The corresponding data set is then available in the Navigation Table.

Figure 6  Loading a Sequence from the ChemStation Explorer into Navigation Table

The main body of the navigation table consists of a list of all runs of the set. Instead of loading a run via the File > Load Signal menu, a run can now be loaded into ChemStation memory by double-clicking the relevant line in the navigation table. Additionally, a right-click on a run offers several options, e.g. to load or overlay specific signals from the file, to export the data, or to view the acquisition method parameters.

Once the run is loaded, you can review it, i.e. adjust data analysis parameters, integrate the signals and finally print a report. In this case you analyze the run as a single run without taking the sequence context into account or without using the features of the sequence table. This type of data analysis is called Data Review. The Navigation Table provides the tool set shown in Figure 7 on page 21, which makes data review more convenient.
Figure 7  Data Review Toolset of the Navigation table

With this toolset, you can jump to the beginning or end of the navigation table, step on to next or previous run, automatically step through the runs, and stop automatic stepping.

A different way to analyze your data is to Reprocess a complete sequence. During this process, all runs are reanalyzed in the sequence context, i.e. the calibration tables of the sequence methods are updated in the case of calibration runs, multipliers, amounts etc. can be changed in the sequence table, new methods can be added to the sequence container, etc. For reprocessing, the navigation table provides the following toolset:

Figure 8  Sequence Reprocessing Toolset of the Navigation Table

Note that the reprocessing icons in the navigation table are available only for sequence data generated with ChemStation B.02.01 and higher. For single run data, for data generated prior to B.02.01, and for data acquired while Unique Folder Creation is switched off (see “Workflow with Unique Folder Creation switched off” on page 37), reprocessing in Data Analysis is not accessible. Such sequences need to be reprocessed in Method and Run Control, defining the sequence parameter Part of method to run as Reprocess Only. For sequences generated with ChemStation B.02.01 and higher, the reprocessing option in Method and Run Control has been removed (see Figure 9 on page 22), and the navigation table offers reprocessing as a Data Analysis Task.
3 Data Analysis

Figure 9  Sequence Parameters in **Method and Run Control** view of ChemStation B.02.01 and higher
Data Analysis: Data Review

Data Review means analyzing on a run-per-run base. ChemStation allows you to specify default actions that are performed automatically when a data file is loaded from the Navigation Table. These include data analysis tasks like integrating the chromatogram directly after loading, and also specifying the method that is to be loaded.

The corresponding options for reviewing (not used for reprocessing) are set up on the Signal/Review Options tab of the Preferences dialog box.

![Preferences Dialog / Signal/Review Options Tab](image)

The first section, Load Signal Options, specifies which of the signals in a run are loaded, and if the chromatograms are to be integrated and the results reported directly after loading.

In the second section, Data Review Options, you have the possibility to configure the interval for stepping through the runs in the navigation table automatically.
The remainder of this section specifies which method is loaded during data review when a run is loaded from the navigation table. They only apply to data review, but not to reprocessing. The following separate option sets are available for sequence runs and single runs:

**Table 1**  Data Review Options for Sequence and Single Run Data

<table>
<thead>
<tr>
<th>Method used for review of sequence data</th>
<th>Method used for review of single run data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Method</td>
<td>Current Method</td>
</tr>
<tr>
<td>Sequence Method</td>
<td>Individual method from data file (DA.M)</td>
</tr>
<tr>
<td>Individual method from data file (DA.M)</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE**

The options on the **Signal/Review Options** tab of the **Preferences** dialog are only applied when loading a data file from the **Navigation Table**. When using **Load Signal** from the **File** menu or the corresponding icon in the main tool bar, the settings are not applied, e.g. no method is loaded.

**Keep “Current Method”**

The review setting **Current Method** should always be used when you want to use the method that is currently loaded. In this respect, for data review the current method remains irrespective of which single run data file or sequence container file is loaded. You can enable this option by selecting **Current Method** in the **Preferences** dialog, see **Figure 11** on page 25. This ensures that, for each run loaded, the same method is always kept in memory.
You can use this option for example in the following workflows:

- You want to review the data files of sequence container with a different method that is not currently in the container, e.g. a master method not used for acquisition because your workflow employs separate acquisition and data analysis methods. At the start of the review you load this different master method, most conveniently from the Method tab of the ChemStation Explorer.

- In the online session, you want to edit the master method used for acquiring the data container. You want to edit both instrument parameters and data analysis parameters as immediate starting point for the next acquisition sequence run.

- You have edited the data analysis parameters of the individual method DA.M for one of the runs in your sequence containers. With the option **Current Method** you can review all runs with this method, in order to check how well these parameters also apply for other runs.
Load “Sequence Method”

When you review the data using the option **Sequence Method** (see Figure 12 on page 26), each time you load a run from the **Navigation Table**, the sequence method corresponding to the run's sequence line is loaded. As the name of this option implies, it is only available for review of sequence data sets, but not of single runs.

A typical application for this option is sequence-specific optimization of data analysis parameters, especially as preparation for reprocessing (see “Data Analysis: Reprocessing Data” on page 32). Once every run has been reviewed and the sequence methods have been improved, the complete sequence can be reprocessed with the updated methods.

It may be necessary to propagate the changes in the sequence method to the corresponding master method as input for all future acquisition runs. You can achieve this conveniently by e.g. using the **Update Master Method** functionality (see Table 3 on page 31).
Load “Individual Method from Data File (DA.M)”

The review setting Individual Method from Data File (DA.M) (see Figure 13 on page 27), should be used, if you want to load the individual DA.M automatically along with the corresponding data file, when this file is loaded using the navigation table. When you change a method and then load the next run, you will be asked to save your method changes, because you load a new method: the DA.M of the next run.

![Preferences window](image)

**Figure 13** Load the Individual Method from Data File for Data Review

With the individual data analysis method (DA.M), it is possible to perform run-specific changes and save them in the individual data analysis method of the run. This may be useful in case of complicated chromatograms that require individual timed integration events for several runs of a sequence.

**NOTE**

When a sequence is reprocessed, all actions are performed on the sequence methods and the DA.M of each data file is overwritten, including any changes you saved in these methods. Optimizing DA.M should be the last data analysis step after final reprocessing has already been performed.
Treatment of manual integration events

Manual integration events, e.g. a manually drawn baseline, are even more data file specific than timed integration events. In case of complicated chromatograms, it is highly desirable to be able to use these events for reprocessing.

Therefore, in ChemStation B.04.01 and higher, manual integration events can be stored directly in the data file instead of the method. At any time the data file is reviewed or reprocessed, the manual events in the data file are automatically applied. A run containing manual integration events is marked in the navigation table in the corresponding column.

In addition to the tools for drawing a baseline and deleting a peak manually, three additional tools are available in the user interface to
- Save manual events of the currently shown chromatograms into the data file,
- Remove all events from the currently shown chromatograms,
- Undo the last manual integration events (available until the event is saved).

When continuing to the next data file during review in the Navigation Table, ChemStation will check for unsaved manual integration events and ask the user whether he wants to save the events.

Manual events stored in the data file during review in the navigation table do not interfere with manual integration events stored during review in the Batch mode. These two ways of review are completely separated with regard to the manual events of a data file.

In ChemStation revisions prior to B.04.01, manual integration events could only be stored in the method. In B.04.01, this workflow can still be used. The Integration menu in Data Analysis view provides the following items in order to handle manual integration events with the method:

**Update Manual Events of Method**: Save newly drawn manual events to the method.

**Apply Manual Events from Method**: Apply the manual events currently saved in the method to the currently loaded data file.

**Remove Manual Events from Method**: Delete the manual events from the method.
In order to convert manual events stored in a method to storage in the data file, apply the events from the method and store the results in the data file. If wanted, remove the events from the method.

In case the Manual Events checkbox of the Integration Events Table of a method is enabled, the manual events of the method are always applied when loading a data file using this method. If the data file contains additional manual events, the events in the data file are used. When the Manual Events checkbox is enabled, the user is never asked to save the events to the data file.
The ChemStation User Interface during Data Review

The ChemStation user interface provides a number of features to facilitate working with the different methods available for data analysis (Figure 14 on page 30).

Figure 14  User Interface in Data Analysis

- The method modification status is displayed in **Data Analysis** view, so you can easily follow if there are unsaved method changes. The user interface always displays the name of the currently loaded method (together with the information whether it is an individual data analysis method of a data file or a sequence method).
- When you move the mouse pointer over this field, a tool tip additionally displays the complete path and name of the method.
- A dropdown box provides a shortcut to the method options of the **Preferences** dialog. You can directly enable any of the available options and it will be applied the next time you load a run from the Navigation Table. Moreover, it is also very convenient to see which option is currently active. Note that these options only apply to data review, but not to reprocessing.

**Saving methods in Data Analysis view**

During work in **Data Analysis** view, the user optimizes the data analysis parameters of his methods. In addition to just saving a method, the workflow may also require e.g. to save a sequence method with different name or as a master method into the master method directory.

The **Method** menu in data analysis provides several items to save the method:
The option **Save as new Master Method** for sequence methods and individual methods DA.M per default have the master method directory preselected as the target directory.

### Update master method feature

In addition, the **Method** menu provides the possibility to make available for the sequence or master method only the data analysis parameters you developed for the individual method. This option, **Update Master Method** or **Update Sequence Method** is available from the **Method** menu or via a right-click in the **Navigation Table** on the corresponding run.

This feature is available in the following situations:

<table>
<thead>
<tr>
<th>Loaded Method</th>
<th>Available Options</th>
</tr>
</thead>
</table>
| Individual data analysis method (DA.M) | Update Master Method  
| | Update Sequence Method |
| Sequence method | Update Master Method |
| Master method | — |

**NOTE**

It is important to note that this feature only updates data analysis parameters of the target method, and that it overwrites all data analysis parameters. For technical reasons, in addition to the data analysis parameters, the Audit Trail of the target method is also overwritten with the Audit Trail of the source method.
Data Analysis: Reprocessing Data

In contrast to data review, sequence reprocessing means that all the runs of a sequence are reanalyzed in the sequence context, i.e. including calibration table updates, parameters changes in the sequence table, additions of new methods to the sequence, etc.

With the new data organization concept, the sequence container includes all files needed for reprocessing: the data files, a copy of the sequence file, and all the sequence methods originally employed with the acquisition. Thus, in order to reprocess a sequence you simply have to load it into the Navigation Table and the required tool set is available.

Figure 15  Toolset for Sequence Reprocessing

Note the following rules with regard to reprocessing:

• When loading a sequence container into the navigation table, ChemStation automatically takes to also load the sequence file .S that is located in this container. This sequence file contains all the sequence lines that are related to any data file belonging to this container.

• All actions are performed on the sequence methods. If changed analysis parameters are to be applied, you have to change the sequence methods.

• The method loading settings of the Preferences dialog have no influence on reprocessing; it always works on the sequence methods or updated sequence methods. This feature set is valid for reviewing only.

• During reprocessing, the Batch (*.b) file, the sequence/single run log (*.log), and the Navigation Table, are updated. The individual data analysis method (DA.M) of each processed data file is overwritten with current sequence method.

NOTE

When a sequence is reprocessed, all actions are performed on the sequence methods and the DA.M of each data file is overwritten, including any changes you saved in these methods. Optimizing DA.M during data review should be the last data analysis step after final reprocessing has already been performed.
If you want to add new methods from one of the master method directories to the sequence table, use the Browse item in the list of methods to browse to any specified method directory (only the methods already in the sequence container are available without browsing). The new method is copied to the sequence container during reprocessing. This implies that you cannot select a method with the same name as a method already present in the container.

![Sequence Table](image)

**Figure 16** Browse to the Master Methods directory in the Sequence Table

- In the sequence table, it is not possible to add or remove lines.
- In the **Sequence Parameters** dialog, only the operator name, the sequence comment, and the usage of sequence table information can be changed. All other fields have to be set during data acquisition or do not apply to reprocessing.
Figure 17  Sequence Parameters in Data Analysis

Saving Sequences in Data Analysis View

The Sequence menu provides the possibility to save the sequence after modifying the sequence table, sequence parameters, or sequence output parameters. In addition it allows you to save a data analysis sequence (that is stored with sequence container) as a sequence template. This functionality may be useful if you have added sequence lines to the sequence table during acquisition. These additional lines are only available in that specific sequence container, but not in the original sequence template.

Saving a sequence as new sequence template automatically converts the sequence file so that all fields are editable again.
4 Workflow with Unique Folder Creation switched off

Working with "Unique Folder Creation" on or off? 36
Workflow with Unique Folder Creation switched off 37
Sequence Container Migration 41

This chapter provides information on working with **Unique Folder Creation** switched off which allows you to store data as in ChemStation revisions B.01.03 or earlier. This mode does not take full advantage of the latest data review and reprocessing functionality in ChemStation.
Workflow with "Unique Folder Creation" on or off?

The new data concept as outlined in the previous chapters provides a number of advantages:

- Sequence data are not overwritten. Each sequence acquisition stores the resulting data files in its own sequence container with unique name.
- With the sequence container concept, the data are stored with all necessary information needed for data analysis, i.e. copies of the sequence file and of all methods employed with the sequence. These methods can be changed with sequence specific input and do not influence the original master method. The container concept thus strengthens the meaning of a sequence as a set of data files and methods belonging together for result creation.
- Data review and reprocessing are both available in Data Analysis view via the Navigation Table.
- The data container concept provides the optimal preconditions for the ChemStation OpenLAB Option, allowing to exchange data with the Agilent OpenLAB Enterprise Content Manager (ECM).

However, there may be situations where users may want to store their data as in ChemStation B.01.03 or earlier and work according to the corresponding workflows:

- During method development it may be more convenient to have only one method for both acquisition and data analysis to automatically have changes available for future acquisition and reanalysis of already acquired data.
- Data from several acquisitions have to be in one folder, e.g. in case of partial acquisition.
- Customized macro solutions on a ChemStation system that have been designed for older revisions may require the data, methods, or sequence to be stored according to the old data organization scheme.
- When ChemStation B.04.01 runs in a lab where there are also system still running on ChemStation revisions B.01.03 or earlier, it may be more convenient to use the same data organization mode on all systems.
Workflow with Unique Folder Creation switched off

In order to allow working with a data storage concept as in ChemStation revisions before B.02.01, the Sequence tab of the Preferences dialog box a Data Storage section. Here you can choose between Unique Folder Creation ON and Unique Folder Creation OFF (Figure 18 on page 37). Per default, Unique Folder Creation ON is selected. Unique Folder Creation ON enables the data storage concept as outlined in the three chapters above.

![Preferences Dialog / Sequence Tab](image)

**Figure 18** Preferences Dialog / Sequence Tab

**NOTE**

Switching Unique Folder Creation on or off only affects future acquisitions, but does not change the data organization of already acquired data.

**NOTE**

We recommend to decide between the two modes at the beginning of your work and not to switch between them.

Switching Unique Folder Creation off is not supported with the ChemStation OpenLAB Option or ChemStore/Security Pack installed.
4 Workflow with Unique Folder Creation switched off

Workflow with Unique Folder Creation switched off

Selecting **Unique Folder Creation Off** has the following impact on data storage:

- Sequence data are not acquired into a sequence container, but directly into the subdirectory as specified in the **Sequence Parameters** (Figure 4 on page 14). Therefore, the sequence name pattern is grayed out on the **Sequence** tab of the **Preferences** dialog (Figure 18 on page 37).

- This means that for two or more sequence acquisitions the data may be acquired into the same subdirectory. This implies the risk to overwrite existing data, but on the other hand allows to split sequences using partial sequence execution and still combine the results in one folder (which would not be possible with Unique Folder Creation switched on).

- No sequence methods (.M) or copies of the sequence file (.S) are stored with the data, but only the sequence logfile and the batch file (.B). This means only the methods and sequences in the paths specified in the **Preferences** dialog (Figure 2 on page 12) are available. They have to be used for acquisition as well as for data review and reprocessing. Sequence or data file specific method changes can only be stored by saving the method with different name. Otherwise these changes are also applied to the acquisition method. On the other hand, this may be desired behavior during method development.

- There are no data file specific methods ACQ.M and DA.M stored. Saving information about the original acquisition is only possible by including this information in the report or by selecting **Save Method with Data** from the method’s runtime checklist (Figure 19 on page 39). With this option the acquisition method will be stored as RUN.M in each data file.
The enhanced ChemStation user interface as introduced with ChemStation B.02.01 is also available when Unique Folder Creation is switched off. However, there are functions you cannot take advantage of in this mode. The same limitations also apply to any run acquired with ChemStation prior to B.02.01.

- When a sequence is loaded into the Navigation Table, the reprocessing toolset is grayed out (Figure 20 on page 39). Sequences that have been acquired in this data storage mode can only be reprocessed in Method and Run Control view using the Reprocessing only option in the Sequence Parameters (Figure 21 on page 40).
**Figure 21** Reprocessing of sequence data acquired with Unique Folder Creation off

- With the method usage options **Individual Method from Data File** and **Sequence Method** (see Figure 10 on page 23), a warning message will be displayed each time a run is double-clicked in the Navigation Table that the individual method/sequence method does not exist. As outlined above, these methods are not stored with the data. In this case, the only meaningful option for data review is **Current Method**.
Sequence Container Migration

ChemStation provides a tool to migrate non-container data to sequence container format. To successfully perform this task, it is required that the original sequence file is still available. It must contain all the necessary sequence lines and follow the original data file naming scheme to reprocess all the data files of the sequence. In addition, all the methods in the Method column of the sequence table have to be available.

To perform migration,

start the **Sequence Container Migration** from the **Sequence** menu in **Data Analysis** view.

![Sequence Container Migration](image)

**Figure 22**  Sequence Container Migration

Fill in the following required fields (see **Figure 22** on page 41):

**Select Sequence Template**: Select the sequence file .S that contains the sequence table that matches the data set to be migrated.

**Select Method Patch**: Select the directory where the methods are located that are referenced in the sequence table.
Select Source: Select the directory that contains the data files to be migrated.

Select Destination: Specify the path and name of the sequence container to be created. You may select an existing folder or create a new one.

When all fields are filled in, the migration can be started.

The following steps will be performed:

• The sequence container directory will be created.

• The sequence template will be copied to the container. It will also be converted to a state where it is able to reprocess data files in Data Analysis view.

• The methods referenced in the sequence table are copied from the specified method path to the container folder.

• The data files, the sequence logbook, and the batch file are copied from the data source directory to the destination directory.

• According to the information in the sequence table, a copy of the corresponding method is copied to each data file as DA.M.

When the container migration is completed, a success message is displayed in the Messages and Warnings field. Otherwise a warning message indicates any problem during migration. Details about the warning can be obtained by double-clicking the warning message.
Workflow with Unique Folder Creation switched off
Sequence Container Migration
In This Book

With ChemStation revision B.02.01 or higher, data review and data reprocessing capabilities have been significantly improved to enable fast review of result data.

The new data storage functions in ChemStation help to efficiently organize sequence data and methods.